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Introduction

Mastercam Machine Simulation is a safe, cost-effective way of proving out 3-axis, 4-
axis, or 5-axis Mill or Router toolpaths. Machine simulation helps you detect collisions 
between your stock, tool, and any machine components before sending any code to 
your machine tool. You can use machine simulation to test possible multiaxis fixture 
scenarios and find the ideal location for machining a particular job. It is an additional 
tool to help you make clean, efficient, and accurate toolpath programs. 

Tutorial Goals
 Introduce you to the machine simulation workspace.
 Illustrate the machine simulation workflow.
 Show the benefits of using machine simulation.
 Analyze toolpath motion with machine simulation.
 Simulate both 3-axis and multiaxis toolpaths.

Estimated time to complete this tutorial: 2 hours

General Tutorial Requirements
All Mastercam tutorials have the following general requirements:

 You must be comfortable using the Windows® operating system.
 The tutorials cannot be used with Mastercam Demo/Home Learning Edition

(HLE). The Demo/HLE file format (emcam) is different from the Mastercam file
format (mcam), and basic Mastercam functions, such as file conversions and
posting, are unavailable.

 Each lesson in the tutorial builds on the mastery of preceding lesson’s skills.
We recommend that you complete them in order.

 Additional files may accompany a tutorial. Unless the tutorial provides specific
instructions on where to place these files, store them in a folder that can be
accessed from the Mastercam workstation, either with the tutorial or in any
location that you prefer.

 You will need an internet connection to view videos that are referenced in the
tutorials. All videos can be found on our YouTube channel:
www.youtube.com/user/MastercamTechDocs.
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 All Mastercam tutorials require you to configure Mastercam to work in a
default metric or English configuration. The tutorial provides instructions for
loading the appropriate configuration file.

Machine Simulation Tutorial Requirements
In order to run machine simulation, you must have the following:

 Mastercam Mill or Router
 A Mastercam part file with at least one toolpath and a surface or solid model

of the workpiece

IMPORTANT: The following toolpaths or functions are not currently 
supported in machine simulation:

 Lathe

Wire

 Drill 5axis

 Circle Mill 5axis

 Translate, rotate, or mirror (Transform)

 Block drill

 Axis substitution

 Aggregate head

 Non-motion FBM preparation operations

CAUTION: Machine simulation uses the NCI data from Mastercam to 
simulate your toolpaths. It is not a G code simulation product. Also, 
machine simulation does not use the machine definition associated with 
each toolpath. This allows you to choose any available machine model 
and quickly simulate your toolpath.
MACHINE SIMULATION



LESSON 1
1Welcome to Machine Simulation

This chapter introduces you to the Machine Simulation interface, including selecting a 
machine for simulation, running a simulation, and selecting options for displaying your 
part. 

Lesson Goals
 Starting Machine Simulation
 Navigating through the Machine Simulation interface
 Selecting a different machine

Exercise 1: Opening the part file
1 Start Mastercam using your 

preferred method:
 Double-click Mastercam’s 

desktop icon.
Or

 Launch Mastercam from the 
Windows Start menu.

2 Select the default metric configuration file:
a Click the File tab.
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b Choose Configuration from 
Mastercam’s Backstage View to 
open the System Configuration 
dialog box.

c Choose ...\mcamxm.config <Metric> from the Current drop-down list.

d Click OK.
3 Open the Swarf part file that was provided with this tutorial.

NOTE: Machine simulation requires a Mastercam file with solids and/or 
surface geometry. 
MACHINE SIMULATION
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4 Select Levels located with the 
Toolpaths Manager tab to open the 
Levels Manager. 

If the Levels Manager is not displayed, select Levels on the View tab to toggle 
the display.

5 Notice that the part is located on the main level and the fixture is on level 6.
MACHINE SIMULATION
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Exercise 2: Preparing the simulation environment
1 Select the dialog box launcher in the Machine Simulation group on the 

Machine tab. 

The Machine Simulation dialog box displays.
2 To see all the machine configurations installed with Mastercam, select the 

Machine drop-down list at the top of the dialog box. 
MACHINE SIMULATION
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Mastercam includes models of the most popular mill and router machines in 
the industry, including examples of all three major 5-axis machine groups.
 Table/table
 Table/head
 Head/head
The machine names are abbreviated to include information about the 
configuration: 

Vertical or horizontal milling center

Names of axes in machine

Head/head, head/table, or table/table
MACHINE SIMULATION
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3 Select A6_5XRHINO_VMCHTBA from the machine list.
4 Click the Geometry drop-down list.
MACHINE SIMULATION
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By default, Machine Simulation loads all visible surface and solid geometry as 
the workpiece, but you can control this by selecting one of these options.

5 Select All elements from the list.
6 Click the Fixture drop-down list. Select From Level and select level 6.

The options are similar to the Geometry drop-down list.
7 Enter 0.3 for the Simulation tolerance. 

This parameter sets the tolerance for detecting collisions between the part or 
stock and the machine. 
MACHINE SIMULATION
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8 Select Use Mastercam Settings in 
the Colors and shortcuts group 
box.
You can configure Machine 
Simulation’s display colors and 
shortcut keys independent of the 
Mastercam environment. Selecting 
this option reads the Mastercam 
configuration file and sets the colors 
and shortcut keys to match 
Mastercam.

9 To go directly to the simulation, click 
Simulate at the bottom of the 
dialog box. 

Mastercam stores the simulation startup settings in the part file when you 
save the file after running simulation. The next time you open this file, you can 
go directly to running the simulation.
MACHINE SIMULATION
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The simulation interface lies on top of the Mastercam interface and shows the 
part positioned in the machine. 

If you cannot see your part, click Workpiece in the Simulation tab to display 
it. If your display includes additional windows, choose View, Reset to match 
the picture shown above. 

10 Close the CutSim and Measure windows.
11 Select Move List from the View tab.
MACHINE SIMULATION
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The Move List displays the coordinates for each toolpath move.
12 Repeat the previous step and select the following windows:

 Analysis (Toolpath)
 Machine
 Report
All of these windows will be used during the tutorial.
The window layout should now look like the following image:

You may have to dock the Machine tab with the other tabs, as it may appear 
above the others.
MACHINE SIMULATION
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Exercise 3: Viewing The Simulation
Machine Simulation provides several options for viewing and analyzing your toolpath 
motion in your machine. The VCR-style controls and the slider bar are located in the 
Simulation tab.

1 Select the Simulation tab.
2 Move the indicator to the middle of 

the slider bar.

 Moving the slider bar to the left side decreases the speed of the 
simulation, but increases the detail of the simulation.

 Moving the slider bar to the right side increases the speed of the 
simulation, but decreases the detail of the simulation. The simulation skips 
an increasing number of steps and if a collision occurs in the skipped 
steps, it is still reported. 

3 Click Run to begin the simulation.
The simulation proceeds step by step through the toolpath. Notice that the 
progress bar along the bottom of the screen and the Move List in the upper 
right corner both update as the simulation continues.

4 An error message will display, 
notifying you of a collision. Click Yes 
to All to continue running the 
simulation. 
MACHINE SIMULATION
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When the simulation completes, the 
Report tab lists events that 
happened during simulation. In this 
example, the report indicates that 
the B and A axes collided. Also, 
Value underflow X tells you that 
the X axis position was below the 
axis limits for the indicated tool 
moves.

5 Click on Collision between B1 and A3 in the Report tab and machine 
simulation jumps to where the problem occurs. The two axes that collide 
display in red. 

To look more closely at the motion, move your mouse to the workpiece 
center and roll your mouse wheel to zoom in. 
MACHINE SIMULATION
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6 Click the Move List tab at the bottom of the report window to display the list 
of coordinates for each toolpath move.

7 In the Move List, scroll to line 213, 
which is where the collision begins, 
and press the down arrow on your 
keyboard to step through the next 
several moves in the toolpath.

TIP: You can also move the slider 
on the right side of the Move List up 
and down to move through the tool 
motion.

8 Move the slider on the progress bar at the bottom of the screen all the way to 
the left to start at the beginning of the toolpath.
MACHINE SIMULATION
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9 Click the arrow below Machine in 
the Simulation tab and select 
Workpiece/Stock to show only the 
tool and the workpiece. 
This focus option moves the tool 
around a stationary workpiece.

10 Scroll the mouse wheel to zoom out. 
11 Right-click in the graphics window 

and select Other Views, Left to 
rotate the part to the left view.
Machine Simulation includes many 
standard Mastercam views.
MACHINE SIMULATION



VIEWING THE SIMULATION   21
12 Click and hold the left mouse button while moving the cursor down in the 
simulation window. This action rotates the part down and allows you to see 
the toolpath more clearly.

13 Click Run to play the simulation again.
MACHINE SIMULATION
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The workpiece focus mode lets you concentrate on just the tool motion. 

14 Set the focus back to Machine and set the view to Isometric. 
15 Click Fit to center the machine in the simulation window.

16 Exit the Machine Simulation and return to the main Mastercam screen.
MACHINE SIMULATION
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This exercise includes just a few of the possible viewing options in Machine Simula-
tion. You try more in the following chapters.

Exercise 4: Selecting a Different Machine
One of the benefits of Machine Simulation is being able to prove out a program 
without using machine time. Finding issues early can save you time and money. In this 
exercise, you select a different machine for simulation based on collisions and under-
flow issues found in the previous exercise.

1 Select the dialog box launcher in the Machine Simulation group on the 
Machine tab. 

2 Select the 8_5XDMU_VMCTTBC machine from the Machine drop-down list. 

3 Enter 0.3 for the Simulation tolerance, if necessary.
4 Click Simulate at the bottom of the dialog box to return to simulation. 
MACHINE SIMULATION
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5 Increase the simulation speed with the slider (as shown in Exercise 2) and then 
click Run.

6 When the simulation is complete, click the Report tab to see the results. No 
collisions are reported.

7 Click Exit to close Machine Simulation and return to the main Mastercam 
screen.

Testing your parts in different positions and on different machines is an integral part 
of the machine simulation process. The next chapter goes into more detail on this 
process, including backplot and material removal verification as part of the recom-
mended workflow.
MACHINE SIMULATION
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2Using the Machine Simulation 
Workflow

Now that you have a basic idea of how Machine Simulation works, this lesson goes 
into more detail on how Machine Simulation can fit into your machining process. 
Adding Machine Simulation to your workflow helps you choose the best setup for 
each part and machine.

Lesson Goals
 Backplotting toolpaths to analyze toolpath motion
 Simulating toolpaths to check fixturing and machine motion
 Verifying toolpaths to confirm material removal

Exercise 1: Backplotting the Toolpaths
The first step is to check the quality of the toolpath motion using Mastercam’s Back-
plot function, which lets you closely examine the tool motion to make sure it meets 
your needs.

1 From the Mastercam menu, choose File, Open and open the part file, 
visering, provided with this tutorial.

NOTE: This part is configured in inches, so you are prompted to switch 
from inch to metric. Choose All settings and click OK to continue.
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2 If necessary, press [Alt+S] to shade the part. 

The toolpaths included in the part file machine the green area of the part. This 
part is ideal for 5-axis toolpaths, because you can potentially machine the 
whole part in one setup. This would be difficult on a 3-axis machine.

3 Use the Levels Manager to display the vise on Level 2.
MACHINE SIMULATION
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This is just one possible fixturing solution for this part. In every case, you must 
decide how to hold the part in the machine.

4 Select all the toolpaths in the 
Toolpaths Manager and click 
Backplot selected operations.
The Backplot dialog box displays.
MACHINE SIMULATION
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5 Click Options on the Backplot 
dialog box to adjust the display 
settings before running the 
backplot.

6 Deselect the following parameters on the Backplot Options dialog box:
 Simulate Axis Substitution

 Simulate Rotary Axis

 Display vectors 

Turning these options off keeps the part stationary in the graphics window 
and moves the tool around the part.

7 Click OK to close the Backplot Options dialog box.
8 Turn on Display tool and Display 

holder on the Backplot dialog box 
to see the tool and holder during 
the backplot.

9 Click Play on the Backplot VCR bar to run the backplot.
MACHINE SIMULATION
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As the backplot progresses, watch the tool and holder for any collisions with 
the part or fixture. Rotate the part or zoom out if necessary to get a better 
view of the tool motion. 

10 Click OK on the Backplot dialog box when the backplot is complete.
The tool motion looks good so far. The next step is to simulate the motion on 
a machine.

Exercise 2: Preparing and Simulating the Toolpaths
Backplotting toolpaths is a good initial step to check the tool motion, but it can only 
display the tool and holder. It cannot show you how the rest of the machine compo-
nents move around the part. Machine Simulation lets you visualize how all parts of the 
machine move when processing the toolpaths.
Before you begin the next exercise, you add a new machine to select for simulation. 
This procedure is helpful if you create a new machine that matches one in your shop. 
MACHINE SIMULATION
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For more information on additional machines for simulation, please contact your local 
Mastercam Reseller. 

1 Copy the HERMLE800 folder provided with this tutorial to the following 
location: 
C:\Users\Public\Public Documents\shared Mcam 

2017\MachineSimulation\MachSim

Each folder represents a machine and contains the files needed to simulate 
that machine:
 XML file with the kinematic machine structure
 GIF file that displays in the startup settings dialog box
 STL models that represent the machine’s physical components

2 Select the dialog box launcher in the Machine Simulation group on the 
Machine tab. 
MACHINE SIMULATION
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3 Set the following parameters:

 Click the Machine drop-down list and select the Hermle800 machine 
that now appears in the list.

 Set Geometry to From Level and 5.
 Set Position to Translation in XYZ. 
 Set Y to 2.5 and Z to -3.
 Select From Level and select level 2.

 Enter 0.012 for the Simulation tolerance.
MACHINE SIMULATION
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4 Click Simulate to display the part in the machine.

If necessary, set Machine Housing to Show and set Simulation to focus on 
the Machine.
MACHINE SIMULATION
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5 Click Isometric and Fit to display the entire machine in the simulation 
window.

Exercise 3: Viewing the Simulation
1 Click Run to begin the simulation.
2 The Report tab displays collisions in operations 2 and 4.

3 Click on the first collision in the Report tab to jump to that toolpath section.
MACHINE SIMULATION
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4 Zoom in to the collision by scrolling your mouse wheel.

The fixture is colliding with a section of the tool spindle. 
5 To get a better view of what 

components are colliding, click the 
Machine tab.

6 Right-click the Geometry5 
component under the Z axis and 
choose Transparent. 
You can now see through the 
spindle housing to get a better view 
of the collision.
MACHINE SIMULATION



VIEWING THE SIMULATION   35
7 Right-click the Geometry7 component and choose Transparent to provide 
even more visibility.

8 Select the Report tab to return to the operation list.
9 Click on the first collision in 

Operation 4.

10 In the Simulation tab, click the drop-
down list below the Machine 
Housing button and select Hide to 
simplify the machine display. 

11 Right-click in the graphics view and select Other Views, Right to move to the 
right side view.
MACHINE SIMULATION
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This position gives you a better view of the collision between the spindle and 
the fixture.
MACHINE SIMULATION
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12 On the side of the Move List, pull the slider bar down to step through the 
two collisions in this operation.

13 Exit Machine Simulation when you are satisfied and return to Mastercam.

Exercise 4: Adjusting the Fixture
By using machine simulation, you can see that this fixture is not optimal for the 
selected machine. Machine Simulation makes it easy to try different types of fixturing 
and avoid costly mistakes while running the machine.

1 Select the dialog box launcher in the Machine Simulation group on the 
Machine tab.
MACHINE SIMULATION
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2 Set the fixture to Level 7.

3 Click Simulate.
4 Reset the Machine Housing to Show.
5 Click Isometric and Fit to display the entire machine in the simulation 

window.
6 Click Run to simulate the toolpaths. 

The new, smaller fixture causes no collisions. 
7 Click Exit to return to the main Mastercam screen.
MACHINE SIMULATION
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Exercise 5: Verifying Material Removal
Now that you feel confident running the toolpaths on this machine, the final step is to 
check the stock’s shape after running the toolpaths. Machine Simulation includes the 
necessary material removal verification tools.

1 Select the dialog box launcher in the Machine Simulation group on the 
Machine tab.

2 Set the stock to From Level and set it to level 4.

3 Click Simulate.
Because you selected stock in the simulation settings, machine simulation 
automatically opens in material removal mode. 
MACHINE SIMULATION
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4 Click Run to simulate the toolpaths. 

You can see the tool actually removing material from the part as it moves 
through the toolpaths. 
Flute collisions are reported on two of the operations. One way to fix this 
issue would be to return to Mastercam and extend the tool shank length for 
the tool that is used by these operations.

5 Click Exit to close the simulation window and return to Mastercam.
The final workflow step is to cut the part on the actual machine. Since you have tested 
this machining strategy in several ways, you can feel confident that the part will cut 
correctly.

IMPORTANT: While Machine Simulation lets you experiment with 
multiple cutting strategies and fixture combinations without using valu-
able machine time, there is no substitute for the first run of a part on a 
machine. Always be alert and cautious when running a part for the first 
time on a real machine. 

The next chapter provides information about additional toolpath analysis in machine 
simulation.
MACHINE SIMULATION
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3Toolpath Analysis with Machine 
Simulation

Mastercam’s Machine Simulation provides several tools for evaluating your toolpath 
efficiency and accuracy. These tools can help you determine the best cutting strategy, 
fixturing, and positioning for your multiaxis parts.

Lesson Goals
 Inspecting part positioning
 Analyzing tool motion
 Adjusting analysis options

Exercise 1: Analyzing Before Fixturing
Machine Simulation’s toolpath analysis can provide useful information even before 
you select a method for holding your part in your machine. You can see if the tool 
motion works in a virtual environment before using valuable machine time.

1 From the Mastercam menu, choose File, Open. Open the part file, curve_5x, 
provided with this tutorial.
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NOTE: This part is configured in metric units, so you are prompted to 
switch from inch to metric. Choose All settings and click OK to continue.

2 Click Run on the Machine tab.

The part file has a simulation machine and position already assigned. 

3 Click Run to begin the simulation.
MACHINE SIMULATION
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4 Select the Report tab.
Machine Simulation reports a value 
underflow in the Z axis. This 
message means that the Z axis 
position was below the axis limits for 
the indicated tool moves.

5 Click on the issue in the Report tab and machine simulation jumps to where 
the problem occurs.

6 Zoom in to the part and click Right to get a clearer view.

7 Step through the toolpath’s problem section. 
Before you even select a fixture for the part, you can see that the part has 
problems on this machine. You may need to select a different machine in your 
shop or position the part closer to the table to avoid the reported issues.

8 Click Exit to close Machine Simulation.
MACHINE SIMULATION
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Exercise 2: Analyzing Before Machine Selection
No matter what machine you select, Machine Simulation includes analysis tools that 
provide additional details on your toolpaths. These details may affect what machine 
you select for your part.

1 From the Mastercam menu, choose File, Open. Open the part file, 
split_impeller, provided with this tutorial.

2 Select the second toolpath in the 
Toolpaths Manager. 
Machine Simulation only displays 
the selected toolpaths.
MACHINE SIMULATION
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3 Select the dialog box launcher in the Machine Simulation group on the 
Machine tab. 

The basic 5AxHeadHead machine is selected by default.
4 Enter 0.3 for the Simulation tolerance.
5 Click Simulate to display the part. No machine displays.
6 Click Run to watch the toolpath motion on the part.
MACHINE SIMULATION
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If the toolpath is not displayed, click Toolpath in the Visibility section of the 
Simulation tab.

7 To see the tool motion more clearly, 
click the Machine tab, right-click on 
the workpiece in the tree control, 
and choose Hide.

8 Click the Analysis tab.
This tab includes many options for 
closely inspecting your toolpath 
motion.

9 Select B Axis Reversal from the 
drop-down list at the top of the tab.
This analysis option changes the 
toolpath color every time the 
rotation axis changes direction. The 
color changes can help you identify 
areas where direction changes could 
impact your surface quality.
MACHINE SIMULATION
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10 Rotate the part and zoom in if necessary to get a better view of the color 
changes.

According to the color key in the Analysis tab:
 Blue = positive axis direction moves
 Green = negative axis direction moves
 Red = axis direction reversal
The red areas could create pattern marks on your surface if you are running 
an older machine. You may be able to work around these areas by adjusting 
the part in the machine.
MACHINE SIMULATION
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11 To change the color for negative axis 
direction moves and make them 
easier to see, double-click the green 
square to display the Colors dialog 
box.

12 Select the yellow color from the Colors dialog box and click OK. 

13 Click Refresh on the Analysis tab to 
update the colors in the simulation 
window.
MACHINE SIMULATION
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The new color provides a better contrast and makes it easier to see the 
direction changes.

14 Select Sequence from the drop-down list at the top of the Analysis tab.
This analysis colorizes the toolpath in a “hot to cold” gradient, which identifies 
the following attributes:
 Machining start and end points
 Cutting method (zigzag or one way)
 Cut order (inside to outside, outside to inside)
MACHINE SIMULATION
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The default colorization uses ten gradients, starting with red at the beginning 
of the toolpath and ending with blue. You can see where the toolpath begins 
and ends and that it moves in a zigzag pattern.
MACHINE SIMULATION
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TIP: You can add more gradients by clicking the Add button at the top of 
the Analysis dialog box.

15 Click Exit to return to the main Mastercam screen.
These analysis options help you adjust your toolpaths to be more efficient and effec-
tive. To learn more about analysis options and about the Machine Simulation in 
general, press [F1] while in the Machine Simulation window to bring up the Help. 
Although you might think that Machine Simulation is mainly for multiaxis toolpaths, 
the following chapter demonstrates the benefits for 3-axis toolpaths as well.
MACHINE SIMULATION
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MACHINE SIMULATION
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4Machine Simulation for 3-Axis Toolpaths

Whether you’re creating 3-axis or 5-axis toolpaths for your parts, Machine Simulation 
lets you see your part being machined virtually so you can optimize your toolpath 
motion. Even 3-axis toolpaths can benefit from the stock removal and fixture testing 
that Machine Simulation offers.

Lesson Goals
 Using an STL file to simulate stock removal
 Testing fixturing options in Machine Simulation
 Creating a presentation of simulation results

Exercise 1: Simulating Stock Removal
Besides simulating machine motion, Machine Simulation can show stock removal to 
confirm your final part shape.

1 From the Mastercam menu, choose File, Open. Open the part file, 
pocket_vise, provided with this tutorial.

NOTE: Mastercam will ask you to switch from Metric to English. Select 
All settings and click OK.
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2 Use the Levels Manager to display the vise on level 1000, the jaw on level 
1001, and the stop on level 1002.

3 Fit the part and fixture in the graphics window.

4 Select all the toolpaths in the Toolpaths Manager.
MACHINE SIMULATION
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5 Select the dialog box launcher in the Machine Simulation group on the 
Machine tab. 

Machine Simulation is already set to use a 3-axis vertical machining center.
MACHINE SIMULATION
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6 Click Simulate to display the part in the machine.

If you don’t see the workpiece, click the drop-down arrow below the 
Workpiece button and select Show.

7 Confirm that Toolpath is selected to display the tool motion.
MACHINE SIMULATION
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8 Zoom into the part and click Run to view the simulation.

9 When the simulation is complete, click Exit to return to the main Mastercam 
screen.
Now that you’ve seen the basic tool motion, you can adjust the simulation 
environment to check stock removal and test fixturing.

Exercise 2: Adding a Fixture and Stock
1 Select the dialog box launcher in the Machine Simulation group on the 

Machine tab.
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2 Click the Fixture drop-down list and 
select Selected elements. 

3 Click the button to the right of the Fixture drop-down list.
4 Select the vise, jaw, and stop in the graphics window and press [Enter] to 

return to the dialog box.

5 Click the Stock drop-down list and select Load STL file.
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6 Click the button to the right of the Stock drop-down list and select 
pocket_stock.stl that was provided with this tutorial.

7 Click Simulate. 
8 Hide the Workpiece and the Toolpath.

9 Zoom in on the part in the machine. The STL file displays as blank stock. 
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10 Click Run to view the material removal.

11 Click Exit to return to the main Mastercam screen.

Exercise 3: Simulating with Different Fixtures
As you’ve seen with 5-axis toolpaths, using Machine Simulation to test out different 
fixtures can save you valuable time and money. You can do the same with 3-axis tool-
paths.

1 From the Mastercam menu, choose File, Open. Open the part file, plate, 
provided with this tutorial.
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2 Press [Alt+S] to shade the part, if necessary.

3 Use the Levels Manager to display the vise on level 999.
4 Fit the part and fixture in the graphics window.
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5 Select all the toolpaths in the Toolpaths Manager except the FBM Mill 
operation.

NOTE: Machine Simulation does not support non-motion FBM prepara-
tion operations.

6 Select the dialog box launcher in the Machine Simulation group on the 
Machine tab.

7 Use the following parameters on the Simulation tab:
 Select 1_3AXGEN_VMC from the Machine drop-down list.
 Select From Level from the Fixture drop-down list and select 999.
 Select Use Mastercam stock definition from the Stock drop-down list.
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 Enter 0.012 for the Simulation tolerance.

8 Click Simulate to display the part in the machine.
9 Use the following buttons on the toolbar to make it easier to see the 

toolpaths and stock removal:
 Click Toolpath on the Simulation 

tab to display the tool motion.

 Confirm that the Workpiece is 
hidden.
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 Confirm that the Stock is 
displayed.

 Click Current Op. This option 
displays one toolpath at a time 
using the color assigned to that 
operation.

 Click Follow. This option displays 
the path that has been machined.
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10 Zoom in on the part and click Run to view the simulation.

11 When the simulation is complete, click Exit to return to the main Mastercam 
screen.
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Conclusion
Congratulations! You have completed the Machine Simulation tutorial. Now that you 
have mastered the skills in this tutorial, explore Mastercam’s other features and func-
tions. 
You may be interested in other tutorials that we offer. The Mastercam tutorial series is 
in continual development, and we will add modules as we complete them. Visit our 
website, or select Help, Tutorials from the File tab to see the latest publications.

Mastercam Resources
Enhance your Mastercam experience by using the following resources:

 Mastercam Help—Access Mastercam Help by selecting Help, Contents from 
Mastercam’s File tab or by pressing [Alt+H] on your keyboard. Also, most 
dialog boxes, function panels, and ribbon bars feature a Help button that 
opens Mastercam Help directly to related information. 

 Mastercam Reseller—Your local Mastercam Reseller can help with most 
questions about Mastercam.

 Technical Support—CNC Software’s Technical Support department (860-875-
5006 or support@mastercam.com) is open Monday through Friday from 8:00 
a.m. to 5:30 p.m. USA Eastern Standard Time.

 Mastercam Tutorials—CNC offers a series of tutorials to help registered users 
become familiar with basic Mastercam features and functions. The Mastercam 
tutorial series is in continual development, with new modules added as we 
complete them. Visit our website, or select Tutorials from the Help menu to 
see the latest publications.

 Mastercam University—CNC Software sponsors Mastercam University, an 
affordable online learning platform that gives you 24/7 access to Mastercam 
training materials. Take advantage of more than 180 videos to master your 
skills at your own pace and help prepare yourself for Mastercam Certification. 
For more information on Mastercam University, please contact your 
Authorized Mastercam Reseller, visit www.mastercamu.com, or email 
training@mastercam.com. 

 Online communities— You can find a wealth of information, including many 
videos, at www.mastercam.com. For tech tips and the latest Mastercam news, 
follow us on Facebook (www.facebook.com/mastercam), Twitter 
(www.twitter.com/mastercam), or Google+ (plus.google.com/+mastercam). 
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Visit our YouTube channel to see Mastercam in action (www.youtube.com/
user/MastercamCadCam)!  
Registered users can search for information or ask questions on the 
Mastercam Web forum, forum.mastercam.com, or use the knowledge base at 
kb.mastercam.com. 
To register, select Community, Link Account from the File tab, and follow 
the instructions.

Mastercam Documentation
Mastercam installs the following documents in the \Documentation folder of your 
Mastercam installation:

 What’s New in Mastercam 2017
 Mastercam 2017 Installation Guide
 Mastercam 2017 Administrator Guide
 Mastercam 2017 Transition Guide
 Mastercam 2017 Quick Reference Card
 Mastercam 2017 ReadMe

Contact Us
For questions about this or other Mastercam documentation, contact the Technical 
Documentation department by email at techdocs@mastercam.com.
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